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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category

Description

Product Name

HP EliteBook 2560p Notebook PC

Processors Intel® Core™ i7 processor (supports Intel Turbo Boost Technology):
e Intel Core i7-2620M 2.70 GHz processor, (turbo up to 3.40 GHz), 4 MB L3 cache, 4 threads,
standard-voltage (35-W)
Intel® Core™ i5 processors (support Intel Turbo Boost Technology):
e Intel Core i5-2540M 2.60 GHz processor, (turbo up to 3.30 GHz), 3 MB L3 cache, 4 threads,
standard-voltage (35-W)
e Intel Core i5-2520M 2.50 GHz processor, (turbo up to 3.20 GHz), 3 MB L3 cache, 4 threads,
standard-voltage (35-W)
e Intel Core i5-2430M, 2.40GHz, (turbo up to 2.90GHz) 3MB L3 Cache, 4 threads 35W
e Intel Core i5-2410M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 4 threads,
standard-voltage (35-W)
Chipset Mobile Intel QM67 chipset
Graphics Intel® HD Graphics 3000
Supports two simultaneous displays
Panel 31.75 cm (12.50 in) high definition (HD), light-emitting diode (LED), AntiGlare (AG) SVA
Supports privacy filter
Supports 16:9 resolution
Supports 1366x768 resolution
Memory 2 customer-accessible/upgradable memory module slots—DDR3 PC3-10600 (1333MHz) SODIMM

Supports up to 16 GB of system RAM in the following configurations:

e 2048 MB total system memory (2048x1)

e 3072 MB total system memory (2048+1024)

e 4096 MB total system memory (4096%1)

o  4096-MB total system memory (2048 x 2)

e 6144 MB total system memory (4096+2048)

e 8192 MB total system memory (8192x1)

e 8192 MB total system memory (4096x2)

e  12288MB total system memory (8192MB + 4096MB)
e  16384MB total system memory (8192MB x 2)
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Category

Description

Internal storage

Supports the following 6.35 cm (2.5 in) storage devices:
e 750 GB hard drive (7200-rpm, SATA)
e 500 GB hard drive (7200-rpm, SATA)
e 320 GB hard drive (7200-rpm, SATA)
e 320 GB Self-Encrypting Drive (SED) hard drive (7200-rpm, SATA)
e 250 GB hard drive (7200-rpm, SATA)
—or—
e 160 GB solid-state drive
e 128 GB solid-state drive

Optical drives

Customer-accessible

Serial ATA 9.5 mm tray load

Supports the following drives:
e DVD*RW and CD-RW SuperMulti Double-Layer Drive
e DVD-ROM Drive

Audio and video

Integrated dual-array microphones

2 stereo speakers

Integrated 720p HD webcam

Supports “no webcam” option

Modem

56k v.92 MDC data/fax modem

Supports “no modem” option

Modem cable not included

Ethernet

Intel 82579-LM 10/100/1000 GB network interface card (NIC) with iAMT 7.0 support

S3/S4/S5 wake on LAN

NIC power-down technology

Ethernet cable not included

Wireless

Integrated wireless local area network (WLAN) options by way of wireless module

Three WLAN antennas

Support for "no WLAN" option

Support for the following WLAN formats:

e  Broadcom 43224AGN 802.11a/b/g/n WLAN module

e  Broadcom 4313AGN 802.11a/b/g/n WLAN module

e Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter
e Intel Centrino Ultimate-N 6300, 3x3 a/g/n WiFi Adapter

Integrated wireless wide area network (WWAN) options by way of wireless module

Two WWAN antennas built into display assembly (world-wide, 5-band)
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Category

Description

Support for "no WWAN" option

Security provided by subscriber identify module (SIM) located inside battery bay

Support for the following WWAN formats:
e  HP un2430 EV-DO/HSPA Mobile Broadband Module
° HP hs2340 HSPA+ Mobile Broadband Module

Integrated personal area network (PAN) options by way of Bluetooth® module:

HP Integrated Module with Bluetooth 2.1 Wireless Technology

Support for “no WPAN” option

External media card

One ExpressCard/34 slot, supporting USB and PCle ExpressCard modules

One Digital Media Reader, supporting MultiMediaCard (MMC) and Secure Digital (SD) Memory Card

Ports e eSATA/USB 2.0 Combo Port
e USB 2.0 Port
e  USB 2.0 charging port
e  3-pin AC power
° Headphone/microphone combo audio
e  DisplayPort
e  Docking connector
e RJ-11 (modem)
e RJ-45 (Ethernet, includes link and activity lights)
e VGA (Dsub 15-pin) supporting 1920 x 1200 external resolution at 75-Hz (hot plug/unplug with
auto-detect)
Docking HP 2560 Docking Station

Keyboard/pointing
devices

Full-size keyboard with Dura-Keys

Dual point (pointing stick and TouchPad with scroll zone)

Spill-resistant keyboard with HP drainage system

TouchPad covered by glass, with a chemically etched surface

Power requirements

65-W HP Smart AC adapter with localized cable plug support (3-wire plug with ground pin, supports
3-pin DC connector)

Supports HP Fast charge technology (select batteries only)

Supports the following batteries:

e  9cell, 3.00 Ah (100 Wh) Li-ion battery (does not support Fast Charge)
e 6 cell, 2.80 Ah (62 Wh) Li-ion battery

e 6 cell, 2.80 Ah (55 Wh) Li-ion long-life battery

e 3cell, 2.80 Ah (31 Wh) Li-ion battery




4

Category

Description

Security

Integrated fingerprint reader (select models only)
Supports "No Fingerprint Reader" option
Integrated smart card reader (active)

Preboot Authentication (password, smart card)
Full-volume encryption

Security cable slot

Trusted Platform Module (TPM) v.1.2

Operating system

Preinstalled operating systems:
e  Microsoft® Windows® 7 Home Premium 32/64
e  Windows 7 Professional 32/64

e FreeDOS

Preinstalled operating systems, plus Microsoft® Office:

e  Windows 7 Home Basic 32 with Office 2010 Starter

e  Windows 7 Home Premium 32/64 with Office 2010 Starter

e  Windows 7 Home Premium 32/64 with Office 2010 Personal

e  Windows 7 Home Premium 32/64 with Office 2010 Home & Business
e  Windows 7 Home Premium 32/64 with Office 2010 Professional

e  Windows 7 Professional 32/64 with Office 2010 Starter

e  Windows 7 Professional 32/64 Office 2010 Personal

e  Windows 7 Professional 32/64 Office 2010 Home & Business

e  Windows 7 Professional 32/64 Office 2010 Professional

Restore media (OSDVD):
e Windows 7 Home Basic 32
e  Windows 7 Home Premium 32/64

e  Windows 7 Professional 32/64

Certified:
e  Microsoft WHQL
e  SUSE Linux

° Novell

DRDVD (Device driver and Application DVD) for Windows 7

Chapter 1 Product description



Category

Description

Web-only support:

Windows 7 Enterprise 32/64
Windows 7 Ultimate 32/64
Windows Vista Business 32/64
Windows Vista Enterprise 32/64
Windows XP Professional 32

Serviceability

End-user replaceable parts:

AC adapter
Battery

Memory module
Hard drive
Optical drive
WLAN module
WWAN module
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2 External component identification

Top
TouchPad

ol

‘D
B il
e— | —o

Component Description

(1) Pointing stick Moves the pointer and selects or activates items on the
screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

3) . TouchPad on/off button Turns the TouchPad on and off.

(4) TouchPad zone Moves the pointer and selects or activates items on the
screen.

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right pointing stick button Functions like the right button on an external mouse.

(7) Right TouchPad button Functions like the right button on an external mouse.

Chapter 2 External component identification



Lights

==
- -
Component Description
1) {l} Power light e  White: The computer is on.
e  Blinking: The computer is in the Sleep state.
e  Off: The computer is off or in Hibernation.
(2) Num lock light White: Num lock is on.
(3) {: :I} Wireless light e  White: An integrated wireless device, such as a
I wireless local area network (WLAN) device and/or a
Bluetooth® device, is on.
e  Amber: All wireless devices are off.
(4) @ HP QuickWeb light e  White: The computer is on.
e  Off: The computer is off or in Hibernation mode.
NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help.
(5) ‘ E Mute light e  White: Computer sound is on.
e  Amber: Computer sound is muted.
(6) Caps lock light White: Caps lock is on.
(7) TouchPad on/off light e  Amber: The TouchPad is off.

e  Off: The TouchPad is on.

Top
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Buttons and fingerprint reader (select models only)

Component

Description

1) {.!J Power button

When the computer is off, press the power button to
turn on the computer.

When the computer is on, press the power button
briefly to initiate Sleep.

When the computer is in the Sleep state, press the
power button briefly to exit Sleep.

When the computer is in Hibernation, press the power
button briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

Windows 7—Select Start > Control Panel > System
and Security > Power Options.

Windows Vista®—Select Start > Control Panel >
System and Maintenance > Power Options

Or refer to the HP Notebook Reference Guide.

Wireless button

(2) {: I :}

Turns the wireless feature on or off, but does not establish a
wireless connection.

Chapter 2 External component identification



Component

Description

@ @

‘ol

QuickWeb button

e  When the computer is off or in Hibernation mode,
press the button to open HP QuickWeb.

e  When the computer is in Microsoft Windows, press the
button to open the default Web browser.

e  When the computer is in HP QuickWeb, press the
button to open the default Web browser.

NOTE: For more information, refer to “HP QuickWeb” in
this guide and to the HP QuickWeb software Help. If your
computer does not have HP QuickWeb software, the button
does not perform any action or function.

“ 4®

Volume mute button

Mutes and restores speaker sound.

©)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

Top



Keys

Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num Ik key, or the
esc key.

3) -'E Windows logo key Displays the Windows Start menu.

o

(4) Function keys (f3 through f11) Execute frequently used system functions when pressed in
combination with the fn key.

(5) E Windows applications key Displays a shortcut menu for items beneath the pointer.

(6) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad
when pressed in combination with the fn and num Ik keys.

(7) num Ik key Enables/disables the embedded numeric keypad when

pressed in combination with the fn key.

10 Chapter 2 External component identification



Component

Description

(1) Wireless light e  White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

e  Amber: All wireless devices are off.

(2) Power light e  White: Power is on.

Blinking white: The computer is in the Sleep state.

Off: The computer is off or in Hibernation.

()

Battery light

White: A battery is close to full charge capacity.

Amber: A battery that is the only available power source has
reached a low battery level. When the battery reaches a
critical battery level, the battery light begins blinking rapidly.

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4)

Drive light

White: The hard drive or optical drive is being accessed.

Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

5

Display release button

Opens the computer.

(6) Vents (2) Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(7) Speaker Produces sound.

Front
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Right

ryryn
D

Component

Description

(1)

Docking connector

Connects an optional docking device.

)

ExpressCard slot

Supports optional 34mm ExpressCards.

@)

Media Card Reader

Supports the following digital card formats:
e  MultiMediaCard

e  Secure Digital (SD) Card

(4)

Audio-out (headphone) jack/Audio in
(microphone) jack

Connects optional powered stereo speakers, headphones,
earbuds, a headset, or television audio. Also connects an
optional headset microphone.

WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, refer to the
Regulatory, Safety, and Environmental Notices.

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: A 4—conductor audio jack plug headphone with
microphone is needed in order to use the microphone
function.

(5

DisplayPort

Connects an optional digital display device, such as a high-
performance monitor or projector.

(6)

eSATA/USB port

Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional
USB device.

@)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(8)

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

12 Chapter 2 External component identification



Left

RSB

Component

Description

(1)

=

Power connector

Connects an AC adapter

)

o

RJ-45 (network) jack

Connects a network cable. The RJ-45 jack has two activity
indicator lights.

e  Amber: The RJ-45 jack is active.
e  Green: The RJ-45 jack is on.

()

RJ-11 (modem) jack (select models only)

Connects a modem cable.

(4)

Optical drive

Reads and writes (select models only) to an optical disc.

®)

Optical drive light

e  On: The optical drive is being accessed.

e  Off: The optical drive is idle.

(6)

Smart card reader

Supports optional smart cards.

Left
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Display

Component Description

1) WLAN antennas (3)* Send and receive wireless signals to communicate with wireless
local-area networks (WLAN).

(2) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

3) Internal microphone (2) Records sound.

(4) Webcam light (select models only) White: The webcam is in use.

(5) Webcam (select models only) Records video and captures still photographs.

To use the webcam, select Start > All Programs > HP >
HP Webcam.

(6) Keyboard light button and ambient light sensor ~ Turns on the keyboard light and automatically adjusts the
display brightness based on the lighting conditions in your
environment.

(7) Keyboard light Provides light for the keyboard.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region. These notices are located in Help and Support.

14 Chapter 2 External component identification



Rear

Component

Description

External monitor port

(1)
Il

Connects an external VGA monitor or projector.

Connects an optional USB device.

(2) USB port
-

3) yi USB 2.0 charging port
-

Connects an optional USB device.

Rear
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Bottom

Component Description

1) Service access cover latch Releases the service access cover so that it can be
removed.

(2) Battery bay Holds the battery.

3) D Battery release latch Releases the battery from the battery bay.

(4) SIM slot Supports a wireless subscriber identity module (SIM) card.
The SIM card slot is located inside the battery bay.

(5) Drain hole A bottom case drain helps prevent damage caused by
minor accidental spills on the keyboard.

(6) Speakers (2) Produce sound.

(7) Bluetooth compartment Holds the Bluetooth device.

16 Chapter 2 External component identification



Component

Description

Hard drive bay and wireless and memory
module compartments

® =

beded

p)

Contains the hard drive, the wireless LAN module slot, the
WWAN module slot, and the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

(9) Vents (4)

Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

Bottom
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3 lllustrated parts catalog

Serial number location

The service tag, affixed to the bottom of the computer, provides information that may be needed

when troubleshooting system problems.

?

.

©—ryseriat x000000000¢ I RN WAL

&- Product xo00000anocc I NN MINEN

= Warranty: XyxyRy

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number: This alphanumeric identifier is unique to each product.

(3) Product part number: This identifier provides specific information about the product's hardware
components. The part number helps a service technician to determine what components and parts

are needed.

(4) Warranty: This number describes the duration (in years) of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model

description provided on the service tag.

18 Chapter 3 lllustrated parts catalog



Computer major components
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ltem Description

Spare part number

1) 31.75 cm (12.50 in) high definition (HD), light-emitting diode (LED), AntiGlare (AG) 638553-001
SVA display panel

(2) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):
e  For use in Belgium 651390-A41
e  For use in Brazil 651390-201
e  For use in Bulgaria 651390-261
e  For use in the Czech Republic and Slovakia 651390-A81
e  Forusein Denmark 651390-081
e  Foruse in Finland and Sweden 651390-B71
e  Forusein France 651390-051
e  Foruse in French Canada 651390-121
e  Foruse in Germany 651390-041
e Forusein Greece 651390-DJ1
e  For use in Hungary 651390-211
e Forusein Iceland 651390-DD1
e  Foruse in Israel 651390-BB1
e  Forusein ltaly 651390-061
e  Foruse in Japan 651390-291
e  Foruse in Latin America 651390-161
e  Forinternational use 651390-B31
e  Foruse in Africa—French/Arabic 651390-DWA1
e  For use in Norway 651390-091
e  Foruse in Portugal 651390-131
e  Foruse in Russia 651390-251
e  For use in Saudi Arabia 651390-171
e  Foruse in Slovenia 651390-BA1
e  For use in South Korea 651390-AD1
e  Foruse in Spain 651390-071
e  For use in Switzerland 651390-BG1
e Forusein Taiwan 651390-AB1
e  Foruse in Thailand 651390-281
e  Foruse in Turkey 651390-141
e  For use in the United Kingdom 651390-031
e  Foruse in the United States 651390-001

20 Chapter 3 lllustrated parts catalog



Item Description Spare part number
(3) RTC battery 651948-001
(4) Top cover
With TouchPad and fingerprint reader 651375-001
With TouchPad only 651374-001
(5) Function button board 651361-001
(6) TouchPad button board (included with top cover, spare part number 651374-001 and
651375-001)
(7) Power button board 651360-001
(8) Fingerprint reader board 651364-001
(9) System board (includes processor, replacement thermal material, and replacement thermal material cleaning
kit):
For use in all countries and regions except the People's Republic of China and Russia 651358-001
For use only in the People's Republic of China and Russia 651359-001
(10) Function LED board 651362-001
(11) Smart card reader board and cable 651363-001
(12) Security cable slot (included with base enclosure)
(13) Base enclosure 651372-001
(14) Hard drive connector (included with the hard drive spare part kit)
(15) WLAN module
Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, 582564-001

Barbados, Belize, Canada, Guam, and the United States

Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Albania, Algeria, Angola, 582564-002
Argentina, Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh, Belgium,
Benin, Bolivia, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina
Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman Islands, the Central
African Republic, Chad, Chile, Colombia, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic and Slovakia, Denmark, Djibouti, the Dominican Republic, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Estonia, Finland, France, French Guiana, Gabon,
Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea, Guinea- Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India,
Indonesia, Ireland, Israel, Italy, the Ivory Coast, Japan, Jordan, Kazakhstan, Kenya,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg,
Madagascar, Malaysia, the Maldives, Mali, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Morocco, Mozambique, Namibia, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Panama, the People's Republic of China, Peru, the Philippines, Poland, Portugal,
Puerto Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, Sierra Leone, Slovenia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Vincent and the Grenadines, Suriname,
Sweden, Switzerland, Taiwan, Tanzania, Thailand, Togo, Tunisia, Turkey, Ukraine, the
United Arab Emirates, the United Kingdom, the United States Virgin Islands, Uruguay,
Uzbekistan, Venezuela, Vietnam, Yemen, Zimbabwe

Broadcom 4313AGN 802.11a/b/g/n WLAN module 593836-001
Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter 631954-001
Intel Centrino Ultimate-N 6300, 3x3 a/g/n WiFi Adapter 572511-001

Computer major components
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Item Description Spare part number

(16) Hard drive or solid-state drive (bracket included)

6.35 cm (2.50 in) hard drive:

e 750 GB, 7200-rpm hard drive 633252-001
e 500 GB, 7200-rpm hard drive 634925-001
e 320 GB, 7200-rpm hard drive 641672-001
e 320 GB, 7200-rpm Self-Encrypting Drive (SED) hard drive 626978-001
e 250 GB, 7200-rpm hard drive 635225-001

6.35 cm (2.50 in) solid-state drive:

° 160 GB, solid-state drive 651389-001
° 128 GB, solid-state drive 651388-001
17) WWAN module

HP un2430 EV-DO/HSPA Mobile Broadband Module (all countries and regions except 634400-001
the People's Republic of China)

HP hs2340 HSPA+ Mobile Broadband Module 632155-001

(18) Processor

Intel® Core™ i7 processor (supports Intel Turbo Boost Technology):

e Intel Core i7-2620M 2.70 GHz processor, (turbo up to 3.40 GHz), 4 MB L3 cache, 631252-001
4 threads, standard-voltage (35-W)

Intel® Core™ i5 processors (support Intel Turbo Boost Technology):

e Intel Core i5-2540M 2.60 GHz processor, (turbo up to 3.30 GHz), 3 MB L3 cache, = 631255-001
4 threads, standard-voltage (35-W)

e Intel Core i5-2520M 2.50 GHz processor, (turbo up to 3.20 GHz), 3 MB L3 cache, = 631253-001
4 threads, standard-voltage (35-W)

e Intel Core i5-2430M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 653341-001
4 threads, standard-voltage (35-W)

e Intel Core i5-2410M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 638039-001
4 threads, standard-voltage (35-W)

(19) Modem module (56k v.92 MDC data/fax modem) 628824-001
(20) Fan 651378-001
(21) Heat sink 651379-001
(22) Optical drive (includes bezel and bracket):
DVD+RW and CD-RW SuperMulti Double-Layer Drive 651387-001
DVD-ROM Drive 651386-001
(23) Memory modules (PC3-10600, 1333 MHz, DDR3):
8 GB 634091-001
4GB 621569-001
2GB 621565-001
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Item Description Spare part number
(24) Speakers 651377-001
(25) HP Integrated Module with Bluetooth 2.1 Wireless Technology 593836-001
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module
cable. The Bluetooth module cable is included in the Cable Kit, spare part number
651384-001.
(26) Battery
9 cell, 100 Wh, 3.0 Ah, Li-ion battery 632423-001
6 cell, 62 Wh, 2.8 Ah, Li-ion battery 632421-001
6 cell, 55 Wh, 2.8 Ah, Li-ion long life battery 632419-001
3 cell, 31 Wh, 2.8 Ah, Li-ion battery 632417-001
(27) Service access cover 651373-001
Rubber Kit (not shown)—includes bumpers for the outside of the base enclosure 651382-001

Computer major components
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Display components

006 00

000 O

Item Description Spare part number
1) Display bezel
For use with computer models equipped with a webcam 651366-001
For use with computer models not equipped with a webcam 651365-001
(2) 31.75 cm (12.50 in) high definition (HD), light-emitting diode (LED), AntiGlare (AG) 638553-001
SVA display panel
(3) Display Hinge Kit (includes left hinge and bracket, and right hinge and bracket) 651369-001
(4) Hinge covers 651370-001
(5) WWAN cable (included in Antenna Kit, spare part number 651371-001)
(6 WLAN cable (included in Antenna Kit, spare part number 651371-001)
(7) Webcam module (select models only), includes microphone and keyboard light 642796-001
(8) Top cover brackets 651381-001
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Item Description Spare part number

(9) Diplay cable (includes webcam cable and light sensor cable) 651368-001

(10) Display enclosure 651367-001
Ambient light sensor board (not shown) 656622—-001
Internal microphone module (not shown) 642798-001
Display Screw Kit (not shown) 655022-001
Display Miscellaneous Kit includes foil shield for camera 656623-001
Display Panel Support Kit (not shown)—includes display enclosure and antenna 658267-001

Display components
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Mass storage

Item Description Spare part number
1) 6.35-cm (2.50-in) hard drive (includes bracket):
e  750-GB, 7200-rpm hard drive 633252-001
e  500-GB, 7200-rpm hard drive 634925-001
e  320-GB, 7200-rpm hard drive 641672-001
e  320-GB, 7200-rpm Self-Encrypting Drive (SED) hard drive 626978-001
e  250-GB, 7200-rpm hard drive 635225-001
(2) 6.35-cm (2.50-in) solid-state drive (includes bracket):
e  160-GB, solid-state drive 651389-001
e  128-GB, solid-state drive 651388-001
(3) Optical drive (includes bezel and bracket):
e DVD-ROM Drive 651386-001
e DVD+RW and CD-RW SuperMulti Double-Layer Drive 651387-001
(4) Optical drive bracket (included with optical drive)
(5) Brackets for hard drive and solid-state drive (included with hard drive and solid-state
drive)
Hard Drive Hardware Kit (not shown)—includes hard drive connector, hard drive, hard  651380-001

drive bracket, screws, and spacers
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Plastics Kit

Item Description Spare part number
Plastics Kit: 651376-001

(1) Optical drive weight saver

(2) ExpressCard blank

(3) RJ-11 jack cover
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Miscellaneous parts

Description Spare part number

AC adapter

65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin, supports 3-  609939-001
pin DC connector)

65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin, supports 3-  609948-001
pin DC connector) for use in Australia, Bangladesh, Brunei, Cambodia, China, Hong Kong, India,

Indonesia, Japan, South Korea, Laos, Malaysia, Nepal, New Zealand, Pakistan, Philippines,

Singapore, Sri Lanka, Taiwan, Thailand, Vietnam

Ambient light sensor board 656622-001
Bracket Kit 651381-001
Cable Kit (includes Bluetooth module cable and cable) 651384-001
Fingerprint reader board 651364-001
HP 2560 Series Docking Station 651385-001
Internal microphone module 642798-001
Power button board 651360-001

Power cords

For use in Argentina 490371-D01
For use in Australia and New Zealand 490371-011
For use in Brazil 490371-202
For use in Canada and the United States 490371-001
For use in Denmark 490371-081
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in Italy 490371-061
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Africa 490371-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in Thailand 490371-201
For use in Singapore and the United Kingdom 490371-031
Screw Kit 651383-001
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Sequential part number listing

Spare part Description
number

490371-001 Power cord for use in Canada and the United States

490371-011 Power cord for use in Australia and New Zealand

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in Singapore and the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Thailand

490371-202 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

537921-001 HP Integrated Module with Bluetooth 2.1 Wireless Technology

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 651384-001.

572511-001 Intel Centrino Ultimate-N 6300, 3x3 a/g/n WiFi Adapter

582564-001 Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, Guam, and the United States

582564-002 Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Albania, Algeria, Angola, Argentina, Aruba,
Australia, Austria, the Bahamas, Bahrain, Bangladesh, Belgium, Benin, Bolivia, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic and Slovakia, Denmark, Djibouti, the Dominican Republic, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Estonia, Finland, France, French Guiana, Gabon, Gambia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea- Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Japan, Jordan, Kazakhstan,
Kenya, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Madagascar,
Malaysia, the Maldives, Mali, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Morocco, Mozambique,
Namibia, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Panama, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia and
Montenegro, Sierra Leone, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St.
Vincent and the Grenadines, Suriname, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Togo, Tunisia,
Turkey, Ukraine, the United Arab Emirates, the United Kingdom, the United States Virgin Islands, Uruguay,
Uzbekistan, Venezuela, Vietnam, Yemen, Zimbabwe
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Spare part
number

Description

593836-001

Broadcom 4313AGN 802.11a/b/g/n WLAN module

609939-001

AC adapter, 65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin,
supports 3-pin DC connector)

609948-001

65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin, supports 3- pin DC
connector) for use in Australia, Bangladesh, Brunei, Cambodia, China, Hong Kong, India, Indonesia, Japan,
South Korea, Laos, Malaysia, Nepal, New Zealand, Pakistan, Philippines, Singapore, Sri Lanka, Taiwan,
Thailand, Vietnam

621565-001

Memory module, 2 GB (PC3-10600, 1333 MHz, DDR3)

621569-001

Memory module, 4 GB (PC3-10600, 1333 MHz, DDR3)

626978-001

Hard drive, 2.50 in, 320 GB, 7200-rpm Self-Encrypting Drive (SED) hard drive (includes bracket)

628824-001

Modem module (56k v.92 MDC data/fax modem)

631252-001

Processor, Intel Dual Core i7-2620M 2.70 GHz processor, (turbo up to 3.40 GHz), 4 MB L3 cache, 4
threads, standard-voltage (35-W)

631253-001

Processor, Intel Dual Core i5-2520M 2.50 GHz processor, (turbo up to 3.20 GHz), 3 MB L3 cache, 4
threads, standard-voltage (35-W)

631255-001

Processor, Intel Dual Core i5-2540M 2.60 GHz processor, (turbo up to 3.30 GHz), 3 MB L3 cache, 4
threads, standard-voltage (35-W)

631954-001

Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter

632155-001

HP hs2340 HSPA+ Mobile Broadband Module

632417-001

Battery, 3 cell, 31 Wh, 2.8 Ah, Li-ion battery

632419-001

Battery, 6 cell, 55 Wh, 2.8 Ah, Li-ion battery

632421-001

Battery, 6 cell, 62 Wh, 2.8 Ah, Li-ion battery

632423-001

Battery, 9 cell, 100 Wh, 3.0 Ah, Li-ion battery

633252-001

750 GB, 7200-rpm 9.50 mm, 6.35 cm (2.50 in) SATA hard drive (includes bracket)

634091-001

8 GB memory module (PC3-10600, 1333 mHz, DDR3)

634400-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001

500 GB, 7200-rpm 9.50 mm, 6.35 cm (2.50 in) SATA hard drive (includes bracket)

635225-001

250 GB, 7200-rpm 9.50 mm, 6.35 cm (2.50 in) SATA hard drive (includes bracket)

638039-001

Intel Dual Core i5-2410M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 4 threads, standard-
voltage (35-W)

638553-001

31.75 cm (12.50 in) high definition (HD), light-emitting diode (LED), AntiGlare (AG) SVA display panel

641672-001

Hard drive, 320 GB, 7200-rpm 9.50 mm, 6.35 cm (2.50 in) SATA hard drive (includes bracket)

642796-001

Webcam module (select models only), includes microphone and keyboard light

642798-001

Internal microphone module

651358-001

System board for use in all countries and regions except the People's Republic of China and Russia

651359-001

System board for use in only the People's Republic of China and Russia

651360-001

Power button board
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Spare part Description

number

651361-001 Function button board

651362-001 Function LED board

651363-001 Smart card reader board and cable

651364-001 Fingerprint reader board and cable

651365-001 Display bezel for use only with computer models not equipped with a webcam

651366-001 Display bezel for use only with computer models equipped with a webcam

651367-001 Display enclosure

651368-001 Display panel cable (includes webcam module cable and ambient light sensor board cable)

651369-001 Display Hinge Kit (includes left and right display hinges and left and right hinge covers)

651370-001 Display hinge covers

651371-001 Antenna Kit (includes WWAN cables, WLAN cables, and MIMO cable)

651372-001 Base enclosure

651373-001 Service access cover

651374-001 Top cover for use only with computer models not equipped with a fingerprint reader (includes fingerprint
reader board and cable, TouchPad board and cable, TouchPad button board and cable, and TouchPad
bracket)

651375-001 Top cover for use only with computer models equipped with a fingerprint reader (includes fingerprint reader
board and cable, TouchPad board and cable, TouchPad button board and cable, and TouchPad bracket)

651376-001 Plastics Kit
NOTE: See Plastics Kit on page 27 for more Plastics Kit spare part information.

651377-001 Speakers

651378-001 Fan

651379-001 Heat sink (includes replacement thermal material and replacement thermal material cleaning kit)

651380-001 Hard Drive Hardware Kit (includes hard drive connector, hard drive, hard drive bracket, screws, and
spacers)

651381-001 Bracket Kit

651382-001 Rubber Kit (includes bumpers for the outside of the base enclosure)

651383-001 Screw Kit

651384-001 Cable Kit (includes Bluetooth module cable and cable)

651385-001 HP 2560 Series Docking Station

651386-001 DVD-ROM Drive (includes bezel and bracket)

651387-001 DVD+RW and CD-RW Super Multi Double-Layer Drive (includes bezel and bracket)

651388-001 6.35 cm (2.50 in) 128 GB solid-state drive (includes bracket)

651389-001 6.35 cm (2.50 in) 160 GB solid-state drive (includes bracket)

651390-001 Keyboard for use in the United States (includes cable)
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Spare part Description
number

651390-031 Keyboard for use in the United Kingdom (includes cable)

651390-041 Keyboard for use in Germany (includes cable)

651390-051 Keyboard for use in France (includes cable)

651390-061 Keyboard for use in Italy (includes cable)

651390-071 Keyboard for use in Spain (includes cable)

651390-081 Keyboard for use in Denmark (includes cable)

651390-091 Keyboard for use in Norway (includes cable)

651390-121 Keyboard for use in French Canada (includes cable)

651390-131 Keyboard for use in Portugal (includes cable)

651390-141 Keyboard for use in Turkey (includes cable)

651390-161 Keyboard for use in Latin America (includes cable)

651390-171 Keyboard for use in Saudi Arabia (includes cable)

651390-201 Keyboard for use in Brazil (includes cable)

651390-211 Keyboard for use in Hungary (includes cable)

651390-251 Keyboard for use in Russia (includes cable)

651390-261 Keyboard for use in Bulgaria (includes cable)

651390-281 Keyboard for use in Thailand (includes cable)

651390-291 Keyboard for use in Japan (includes cable)

651390-A41 Keyboard for use in Belgium (includes cable)

651390-A81 Keyboard for use in the Czech Republic and Slovakia (includes cable)

651390-AB1 Keyboard for use in Taiwan (includes cable)

651390-AD1 Keyboard for use in South Korea (includes cable)

651390-B31 Keyboard for international use (includes cable)

651390-B71 Keyboard for use in Finland and Sweden (includes cable)

651390-BA1 Keyboard for use in Slovenia (includes cable)

651390-BB1 Keyboard for use in Israel (includes cable)

651390-BG1 Keyboard for use in Switzerland (includes cable)

651390-DD1 Keyboard for use in Iceland (includes cable)

651390-DJ1 Keyboard for use in Greece (includes cable)

651390-DW1  Keyboard for use in Africa—French/Arabic (includes cable)

651948-001 RTC battery

655022-001 Display Screw Kit

656622-001 Ambient light sensor board
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Spare part Description
number

656623-001 Display Miscellaneous Kit

658267-001 Display Panel Support Kit (includes display enclosure and antenna)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flat-bladed screwdriver
e  Magnetic screwdriver
e  Phillips PO and P1 screwdrivers

° Torx 8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

%NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/\ CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm £10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 72 screws that must be removed, replaced, or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When you order parts or request information, provide the computer serial number and model number
provided on the service tag, located inside the battery bay.

?
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Component

Description

(1)

Product name

The product name affixed to the front of the computer.

()

Serial number

An alphanumeric identifier that is unique to each product.

()

Product part number

The identifier that provides specific information about the product's hardware
components. The part number helps a service technician to determine what
components and parts are needed.

(4)

Warranty

The duration of the warranty period for this computer.
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Computer feet

The computer feet are hot-melted to the base enclosure in the locations illustrated below.
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Battery

Description Spare part number
9 cell, 100 Wh, 3.0 Ah Li-ion battery 632423-001
6 cell, 62 Wh, 2.8 Ah Li-ion battery 632421-001
6 cell, 55 Wh, 2.8 Ah Li-ion long life battery 632419-001
3 cell, 31 Wh, 2.8 Ah Li-ion battery 632417-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface, with the battery bay toward you.
2. Slide the battery release latch (1) to release the battery.

3.  Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Service access cover

Description Spare part number

Service access cover 651373-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

Remove the service access cover:

1. Position the computer with the battery bay toward you.

2. Slide the release latch (1), and then slide the cover toward the front of the computer (2).

3.  Remove the cover (3).

©
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SIM

@NOTE: This section applies only to computer models with WWAN capability.

E’%NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).
Remove the SIM:

1. Pressin on the SIM (1). (The module partially ejects from the SIM slot.)
2. Remove the SIM (2) from the slot.

Reverse this procedure to insert the SIM.
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Fan and heat sink

Description Spare part number
Fan 651378-001
Heat sink 651379-001

Before removing the fan and heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service access cover (see Service access cover on page 42).

Remove the fan and heat sink:

1. Position the computer upside down, with the battery bay toward you.

2. Disconnect the fan cable (1) from the system board.

3. Loosen the two Phillips M2.0x4.0 captive screws (2) that secure the fan to the system board.
4

Remove the fan (3).

E‘%NOTE: When you replace the fan, be sure to route the cable correctly so that it is not pinched
by the hard drive.
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5. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive screws (1)
that secure the heat sink to the system board.

6. Slide the heat sink to the left until it clears the base enclosure (2).

7. Remove the heat sink (3).

E%?NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
processor each time the heat sink is removed. Replacement thermal material is included with heat
sink, processor, and system board spare part kits.

Reverse this procedure to install the fan and heat sink.
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Processor

Description Spare part number

Intel Core i7-2620M 2.70 GHz processor, (turbo up to 3.40 GHz), 4 MB L3 cache, 4 threads, 631252-001
standard-voltage (35-W)

Intel Core i5-2540M 2.60 GHz processor, (turbo up to 3.30 GHz), 3 MB L3 cache, 4 threads, 631255-001
standard-voltage (35-W)

Intel Core i5-2520M 2.50 GHz processor, (turbo up to 3.20 GHz), 3 MB L3 cache, 4 threads, 631253-001
standard-voltage (35-W)

Intel Core i5-2430M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 4 threads, 653341-001
standard-voltage (35-W)

Intel Core i5-2410M 2.30 GHz processor, (turbo up to 2.90 GHz), 3 MB L3 cache, 4 threads, 638039-001
standard-voltage (35-W)

Before removing the processor, follow these steps:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the fan and heat sink (see Fan and heat sink on page 44).

Remove the processor:

1.

Loosen the captive screw one-half turn (1).
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2. Lift the processor (2) straight up and remove it.

= NOTE: The gold triangle (3) on the processor must be aligned with the triangle embossed on
the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Memory module

@NOTE: There are two memory module slots, one above the other. Use the same removal procedure
for both slots.

Description Spare part number
8 GB memory module (PC3-10600, 1333 mHz, DDR3) 634091-001
4 GB memory module (PC3-10600, 1333 mHz, DDR3) 621569-001
2 GB memory module (PC3-10600, 1333 mHz, DDR3) 621565-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

/\ CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.
2. Click Support & Drivers > click Drivers & Software.

3. Inthe Enter a product name/number box, type the computer model information, and then click
Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7.  Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.
Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove the service access cover (see Service access cover on page 42).

Remove the memory module:
1. Position the computer with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. The edge (2) of the module opposite the slot rises away from the computer.
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3. Remove the memory module (3) by pulling the module away from the slot at an angle.

= NOTE: The memory module is designed with a notch (4) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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Bluetooth module

Description Spare part number

HP Integrated Module with Bluetooth 2.1 Wireless Technology 537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 651384-001.

Before removing the Bluetooth module, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the Bluetooth module:

1.
2,

3.
4,

Disconnect the Bluetooth module cable (1) from the system board.

Slide the cable (2) out of the clip and away from the routing channel.

Using a thin tool, gently pry the outer edge (1) of the module away from the base enclosure.

Rotate the module (2) away from the base enclosure.
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5. Remove the module (3).

6. If the Bluetooth module cable must be replaced, disconnect the cable from the Bluetooth
module.

Reverse the above procedure to install the Bluetooth module.
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Speaker

Description Spare part number

Speaker 651377-001

Before removing the speaker, follow these steps:

1.

5.
6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the Bluetooth module (see Bluetooth module on page 50).

Remove the speaker:

1.
2,

Disconnect the speaker cable (1) from the system board.

Remove the Phillips M2.0x3.0 screw (2) and the two Phillips M2.0x7.0 screws (3) that secure
the speaker to the base enclosure.

Remove the speaker (4) from the base enclosure.

Reverse this procedure to install the speaker.
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Optical drive

Description Spare part number
DVD+RW and CD-RW SuperMulti Double-Layer Drive 651387-001
DVD-ROM Drive 651386-001

Before removing the optical drive, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the optical drive:

1.
2.
3.

Position the computer with the right side toward you.
Loosen the Phillips M2.5x8.0 captive screw (1) that secures the optical drive to the computer.

Apply outward pressure to the back of the optical drive, and then slide the drive (2) out of the
computer.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

Remove the two Phillips M2.0x3.0 screws (1) that secure the optical drive bracket to the optical
drive.
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6. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Modem module

E%?NOTE: The modem module spare part kit does not include a modem module cable. The cable is
included in the Cable Kit, spare part number 651384-001.

Description Spare part number

Modem module (56k v.92 MDC data/fax modem) 628824-001

Before removing the modem module, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the modem module :

1.
2.
3.

Remove the Phillips M2.0%3.0 screw (1) that secures the modem module to the system board.

Lift the modem module (2) straight up to remove it from the system board.

Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.
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WWAN module

Description Spare part number

HP hs2340 HSPA+ Mobile Broadband Module 632155-001

HP un2430 EV-DO/HSPA Mobile Broadband Module (all countries and regions except the People's  634400-001
Republic of China)

/\ CAUTION: The WWAN module and the WLAN module are not interchangeable.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41).

5. Remove service access cover (see Service access cover on page 42).
Remove the WWAN module:
1. Disconnect the WWAN antenna cables (1) from the terminals on the WWLAN module.

E’%NOTE: The black WWAN antenna cable is connected to the WWAN module “Main” terminal.
The white WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips M2.0x3.0 screws (2) that secure the WWAN module to the computer.
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3. Pull the module (3) away from the slot at an angle.

@NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, 582564-001
Belize, Canada, Guam, and the United States

Broadcom 43224AGN 802.11a/b/g/n WLAN module for use in Albania, Algeria, Angola, Argentina, 582564-002
Aruba, Australia, Austria, the Bahamas, Bahrain, Bangladesh, Belgium, Benin, Bolivia, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon,
Cape Verde, the Cayman Islands, the Central African Republic, Chad, Chile, Colombia, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic and Slovakia, Denmark, Djibouti, the Dominican
Republic, Ecuador, Egypt, El Salvador, Equitorial Guinea, Estonia, Finland, France, French Guiana,
Gabon, Gambia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea- Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, Italy, the Ivory Coast, Japan, Jordan, Kazakhstan, Kenya, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Liechtenstein, Lithuania, Luxembourg, Madagascar, Malaysia, the Maldives, Mali,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Morocco, Mozambique, Namibia, Nepal, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Panama, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto
Rico, Qatar, Romania, Russia, Rwanda, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, Sierra Leone, Slovenia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and
Nevis, St. Vincent and the Grenadines, Suriname, Sweden, Switzerland, Taiwan, Tanzania,
Thailand, Togo, Tunisia, Turkey, Ukraine, the United Arab Emirates, the United Kingdom, the
United States Virgin Islands, Uruguay, Uzbekistan, Venezuela, Vietham, Yemen, Zimbabwe

Broadcom 4313AGN 802.11a/b/g/n WLAN module 593836-001
Intel Centrino Ultimate-N 6300, 3x3 a/g/n WiFi Adapter 572511-001
Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter 631954—001

/\ CAUTION: The WWAN module and the WLAN module are not interchangeable.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41) and the following components:

a. Service access cover (see Service access cover on page 42.)

b. WWAN module (see WWAN module on page 56.)
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

@NOTE: The red WLAN antenna cable is connected to the WLAN module “Main” terminal. The
blue WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2. Remove the two Phillips M2.5%6.0 screws that secure the WLAN module to the computer (2).
(The edge of the module opposite the socket rises.)

3. Pull the module (3) away from the slot at an angle.

@*NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Hard drive or solid-state drive

Description Spare part number

Supports the following 9.50 mm, 6.35 cm (2.50 in) SATA hard drives and solid-state drives:

750 GB, 7200-rpm hard drive 633252-001
500 GB, 7200-rpm hard drive 634925-001
320 GB, 7200-rpm hard drive 641672-001
320 GB, 7200-rpm Self-Encrypting Drive (SED) hard drive 626978-001
250 GB, 7200-rpm hard drive 635225-001
160 GB, solid-state drive 651389-001
128 GB, solid-state drive 651388-001

Before removing the hard drive or solid-state drive, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the service access cover (see Service access cover on page 42).

Remove the hard drive or solid-state drive:

1.
2.
3.

Position the computer with the front toward you.
Loosen the 4 Phillips M2.0x5.0 captive screws (1) that secure the drive to the computer.

Pull up on the tab (2) to remove the drive.
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4. Ifitis necessary to replace the drive connector, remove the connector (3) from the drive.

5. Ifitis necessary to replace the drive bracket, remove the two Phillips M3.0x3.0 screws (1) on
each side of the drive, and then lift the bracket (2) away from the drive.

2]

Reverse this procedure to reassemble and install the drive.
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Keyboard

Country/region Spare part number Country/region Spare part number
Belgium 651380-A41 Northwest Africa 651390-001
Brazil 651380-201 Norway 651380-091
Bulgaria 651380-261 Portugal 651380-131
The Czech Republic 651380-A81 Russia 651380-251
Denmark 651380-081 Saudi Arabia 651380-171
France 651380-051 Slovakia 651380-A81
French Canada 651380-121 Slovenia 651380-BA1
Germany 651380-041 South Korea 651380-AD
Greece 651380-DJ Spain 651380-071
Hungary 651380-211 Sweden and Finland 651380-B71
Iceland 651380-DD1 Switzerland 651380-BG1
Israel 651380-BB1 Taiwan 651380-AB1
Italy 651380-061 Thailand 651380-281
Japan 651380-291 Turkey 651380-141
Latin America 651380-161 The United Kingdom and Singapore 651380-031
The Netherlands 651380-B31 The United States 651380-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41) and the following components:

a. Service access cover (see Service access cover on page 42.)

b. Fan (see Fan and heat sink on page 44.)
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Remove the keyboard:

1. Loosen the three Phillips M2.0x8.0 captive screws that secure the keyboard to the computer.

2. Turn the computer right-side up, and then open the display.

3. Carefully position the open computer on its left side, and then press on the keyboard through the
opening where the fan was removed.

Carefully turn the computer right-side up, with the front toward you.
Rotate the keyboard forward until it rests upside down on the palm rest (1).

Disconnect the mouse cable (2) from the system board.

N o g &

Open the ZIF connector (3) for the keyboard cable, and then remove the cable (4).
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8. Remove the keyboard (5).

Reverse this procedure to install the keyboard.
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RTC battery

Description Spare part number

RTC battery 481089-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41) and the following components:

a. Service access cover (see Service access cover on page 42.)

b. Keyboard (see Keyboard on page 62.)
Remove the RTC battery:

1. Disconnect the RTC cable (1) from the system board.

2. Remove the RTC battery (2) from the socket.

Reverse this procedure to install the RTC battery.
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Base enclosure

Description Spare part number

Base enclosure 651372-001

Before removing the base enclosure, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer, and remove any media cards from
the ExpressCard slot and the Media Card Reader.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the following components:

T o

- o o o

7 @

[—

k.

Battery (see Battery on page 41.)

Service access cover (see Service access cover on page 42.)

SIM (see SIM on page 43.)
Fan and heat sink (see Fan and heat sink on page 44.)

Bluetooth module (see Bluetooth module on page 50.)

Speaker (see Speaker on page 52.)

Optical drive (see Optical drive on page 53.)

Hard drive or solid-state drive (see Hard drive or solid-state drive on page 60.)
WWAN (see WWAN module on page 56.)
WLAN (see WLAN module on page 58.)

Modem module (see Modem module on page 55.)

Keyboard (see Keyboard on page 62.)

Remove the base enclosure:

1. Position the computer right-side up, with the front toward you.

2. Open the ZIF connector for the power button cable (1), and remove the cable (2).

3. Open the ZIF connector for the fingerprint reader cable (3), and remove the cable (4).
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4. Open the ZIF connector for the function board cable (5), and remove the cable (6).

5. Close the display, and position the computer upside down, with the rear toward you.

6. Remove the four Torx 8 2.5x7.0 screws from the hinges.

7. Position the computer with the front toward you. Remove the three Phillips M2.0x7.0 screws (1)
at the front of the computer and the three Phillips M2.0x3.0 screws (2) in the optical drive bay.

8. Remove the three screw covers (3) and the five Torx 8 2.5x7.0 screws (4) along the outside
edges.

9. Remove the three Phillips M2.0x3.0 screws (5) and the two Phillips M1.6 pan-head screws (6)
from the battery bay.

@NOTE: Remove the two pan-head screws with a Phillips #0 screwdriver, using a torque of 1.5
kg/cm.
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10. Remove the base enclosure (7).
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System board

E%?NOTE: The system board spare part kit includes replacement thermal material and a replacement

thermal material cleaning kit.

Description Spare part number
For use in all countries and regions except the People's Republic of China and Russia 651358-001
For use only in the People's Republic of China and Russia 651359-001

Before removing the system board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41) and the following components:

a. Service access cover (see Service access cover on page 42.)

b. Keyboard (see Keyboard on page 62.)

c. Base enclosure (see Base enclosure on page 66.)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

Memory modules (see Memory module on page 48.)
WWAN module (see WWAN module on page 56.)
WLAN module (see WLAN module on page 58.)

Modem module (see Modem module on page 55.)

Fan/heat sink assembly (see Fan and heat sink on page 44.)

Processor (see Processor on page 46.)

Remove the system board:

1.

2
3.
4

Position the computer upside down, with the battery bay toward you.
Remove the ExpressCard blank (1) from the card reader, if you have not already done so .
Open the ZIF connector for the smart card reader cable (2), and then remove the cable (3).

Remove the tape (4) from the display cable, and then disconnect the cable (5).
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5. Pull the wireless cables (6) away from system board.

6. Remove the Phillips M2.0x4.0 screw (1) that secures the system board to the top cover. Use the
optical drive connector (2) to lift the left side of the system board until it rests at an angle, and
then remove the system board (3).

o |

Reverse this procedure to install the system board.
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Top cover

E%?NOTE: The top cover spare part kit includes the TouchPad board and cable, TouchPad button
board and cable, and TouchPad bracket.

Description Spare part number

For use only on computer models equipped with a fingerprint reader (includes fingerprint reader and 651375-001
cable)

For use only on computer models not equipped with a fingerprint reader 651374-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Service access cover (see Service access cover on page 42.)

b. Base enclosure (see Base enclosure on page 66.)

c. System board (see System board on page 69.)

Remove the top cover:
1. Turn the computer upside down, with the front toward you.

2. Remove the wireless cables from the routing channels (1). Remove WLAN 1 and WWAN 5 from
the left channel (2). Remove WLAN 2 and WWAN 3 and 6 from the right channel (3).

3.  Remove the two Phillips M2.0x7.0 screws (4) from the hinges.
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4. Slide the top cover toward you and then lift the cover (5) up to remove it.

—

o

5. Ifitis necessary to replace the TouchPad, remove the two Phillips M2.0x3.0 screws (1) that
secure the TouchPad to the top cover.

6. Slide the TouchPad away from you until the front edge (2) clears the lip of the top cover. Then lift
the TouchPad (3) up.

7. Release the TouchPad cable (4) from the ZIF connector (5), and then remove the cable (6).

Reverse this procedure to install the TouchPad and the top cover.
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Power button board

Description Spare part number

Power button board 651360-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a.
b.
c.
d.

Service access cover (see Service access cover on page 42.)

Keyboard (see Keyboard on page 62.)

Base enclosure (see Base enclosure on page 66.)

Top cover (see Top cover on page 71.)

Remove the power button board:

1.  Remove the tape (1) from the power button cable.

2. Remove the Phillips M2.0x3.0 screw (2) that secures the power button board to the top cover.

3. Slide the board and cable (3) out of the plastic clips.
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Function button board

Description Spare part number

Function button board 651361-001

Before removing the function button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Service access cover (see Service access cover on page 42.)

b. Keyboard (see Keyboard on page 62.)

c. Base enclosure (see Base enclosure on page 66.)

d. Top cover (see Top cover on page 71.)

Remove the function button board:
1. Press down on the plastic clip (1) to release the metal bracket. Remove the bracket (2).
2. Remove the Phillips M2.0x3.0 screw (3) that secures the function button board to the top cover.

3.  Remove the function button board (4).

Reverse this procedure to install the function button board.

74 Chapter4 Removal and replacement procedures



Fingerprint reader board

Description Spare part number

Fingerprint reader board 651364-001

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a.
b.
c.
d.

Service access cover (see Service access cover on page 42.)

Keyboard (see Keyboard on page 62.)

Base enclosure (see Base enclosure on page 66.)

Top cover (see Top cover on page 71.)

Remove the fingerprint board:

1. Remove the Phillips M2.0x3.0 screw (1) from fingerprint reader frame, and then remove the
frame (2).

2. Remove the tape (3) from fingerprint reader cable, and then remove the board and cable (4)
from the top cover.

Reverse this procedure to install the fingerprint reader board.
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Smart card reader

Description Spare part number
Smart card reader (includes cable) 651363-001
Smart card reader bracket 598767-001

Before removing the card reader board and bracket, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a.
b.
c.
d.

Service access cover (see Service access cover on page 42.)

Keyboard (see Keyboard on page 62.)

Base enclosure (see Base enclosure on page 66.)

Top cover (see Top cover on page 71.)

Remove the smart card reader board and bracket:

1. Open the ZIF connector (1) for the smart card cable, and remove the cable (2).

2. Disconnect the cables (3) and (4) from the TouchPad.

3.  Remove the Philips M2.0x3.0 screw (5) that secures the smart card reader board to the top
cover, and then remove the smart card reader board (6).

Reverse this procedure to install the smart card reader board, cable, and bracket.
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Display panel

E%?NOTE: If it is necessary to replace only the display panel, follow the procedure in this section. To
replace internal display components, follow the procedures in this section and then see Display
components on page 80).

Description Spare part number
Display bezel for use with computer models equipped with a webcam 651366-001

Display bezel for use with computer models not equipped with a webcam 651365-001

31.75 cm (12.50 in) high definition (HD), light-emitting diode (LED), AntiGlare (AG) SVA display 638553-001

panel

Before removing the display assembly, follow these steps:

1.

4.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 41).

Remove the display panel:

1.
2.
3.

Turn the computer right-side up, with the front away from you.
Open the display as far as possible.

Flex the inside edges of the top (1), the left and right sides (2), and the bottom (3) of the display
bezel until the bezel disengages from the display enclosure.
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4. Remove the display bezel (4). The display bezel is available using spare part number
651366-001 (for use only with computer models equipped with a webcam) and 651365-001 (for
use only with computer models not equipped with a webcam).

A CAUTION: The display enclosure will be unsupported when the screws are removed. To
prevent damage to the display enclosure, support it before removing the screws in the next step.

5. Remove the four Phillips M2.5x4.0 screws (1) that secure the display hinge covers and the
bottom bracket to the computer.

6. Remove the two Phillips M2.0x2.0screws (2) at the top corners of the display enclosure.

7. Carefully close the display (1).
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8. Gently lift the display enclosure (2) away from display panel, which rests on the keyboard.
9. Lift the tape (3) that secures the display cable to the back of the display panel.
10. Remove the cable from the display panel (4).

11. Remove the two Phillips M3.0x2.0 screws (1) from each display bracket.
12. Lift the display panel (2) away from the brackets.
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Display components

@NOTE: For removal of the display panel alone, see Display panel on page 77). To remove internal
display components, remove the display panel, and then continue with the procedures in this section.

Description Spare part number
Webcam module (select models only), includes microphone and keyboard light 642796-001
Hinge covers 651370-001
Display Hinge Kit (includes left hinge and bracket, and right hinge and bracket) 651369-001

Before removing the internal display components, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 41), and then remove the following components:

a. Display panel (see Display panel on page 77.)

b. Service access cover (see Service access cover on page 42.)

c. Keyboard (see Keyboard on page 62.)

d. Base enclosure (see Base enclosure on page 66.)

To replace the webcam module, follow these steps:
1. Disconnect the webcam module cable (1) from the webcam module.

2. Gently pry the outside edge (2) of the module away from the display enclosure.
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3.  Remove the webcam module (3).

To replace the outer hinge covers, the inner hinge covers, or the hinges and brackets, follow these
steps:

1. Pull the display brackets (1) toward the outside edges of the display enclosure, and remove the
brackets (2).

2. Slide the inside hinge covers (3) toward the inside of the brackets. Slide the outside hinge
covers (4) toward the outside of the brackets.

Reverse this procedure to reassemble the display components.
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5 Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

@NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

E/?’NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

r__*:"/?NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.
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e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

E’%NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore defaults.

Follow the on-screen instructions.

o ~ @ BN

To save your changes and exit, click the Save icon in the lower-right corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

=¥ NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

%NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.

e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

e  System Information
° Identification information for the computer and the

batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

e  Start-up Test—Verifies the system components needed
for starting the computer.

e Runin Test—Runs a comprehensive check on system
memory.

e  Hard Disk Test-Runs a comprehensive self-test on any
hard drive in the system.

e  Memory Test—Runs a comprehensive test on any
memory installed in the computer.

e  Battery Test—-Runs a comprehensive test on any
batteries installed in the computer.

e  Error Log-Displays a log file if any errors have
occurred.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

E%?NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Administrator Tools

Setup BIOS Administrator Password

Set up a BIOS administrator password

User Management (requires a BIOS administrator password)

Create New BIOS User Account

° Select from a list of BIOS users.

e  Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enroliment

Enable/disable HP SpareKey enroliment (enabled by
default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft

AT-P

Enable/disable Anti-Theft Protection.

DriveLock Passwords

e  Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DriveLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the hard

drive or the standard-voltage hard drive in the Upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

Computer Setup menus

85



System Configuration menu

@NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Set a Startup Menu delay (in seconds).

Set the MultiBoot Express Boot Popup delay in
seconds.

Enable/disable Custom Logo (disabled by default).

Enable/disable Display Diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (disabled by default).
Enable/disable SD Card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE Internal NIC boot (enabled by
default).

Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

Set the Legacy Boot Order.

Device Configurations °

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)
° IDE (Integrated Drive Electronics)

° RAID (select models only)
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Select

To do this

Device Configurations (continued)

NOTE: Auvailability of these options varies by computer
model.

e Enable/disable secondary battery fast charge (enabled
by default).

e  Enable/disable HP QuickLook (enabled by default).

° Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb Write Protect (disabled by
default).

e  Enable/disable Virtualization Technology (select models
only; disabled by default).

e  Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

e  Multi Core CPU (enabled by default).
e Intel HT Technology (enabled by default).
e  Enable/disable Wake on USB (enabled by default).

e  Enable/disable Num lock state at boot (disabled by
default).

Computer Setup menus
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Select

To do this

Built in Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable embedded WLAN device radio (select
models only; enabled by default).

Enable/disable the embedded Bluetooth device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

° Disabled

° Boot to Network

° Follow Boot Order

Enable/disable the Ambient Light Sensor.

Enable/disable the Notebook Upgrade bay device
(enabled by default).

Enable/disable the fingerprint device (enabled by
default).

Enable/disable the integrated camera (enabled by
default).

Enable/disable the Power Monitor Circuit (enabled by
default).

Enable/disable the audio device (enabled by default).
Enable/disable a modem device (enabled by default).
Enable/disable the microphone (enabled by default).

Enable/disable the internal speakers (enabled by
default).

Port Options

NOTE: NOTE: All port options are enabled by default.

Enable/disable the serial port.
Enable/disable the parallel port.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

Enable/disable the 1394 port.
Enable/disable the ExpressCard slot.
Enable/disable the Smart Card slot.
Enable/disable the eSATA/USB port.
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Select

To do this

AMT Options

Enable/disable Firmware Verbosity.
Enable/disable AMT Setup Prompt (Ctrl-P).
Enable/disable USB Key Provisioning Support.
Enable/disable Unconfigure AMT on next boot.
Select Terminal Emulation Mode.

> ANSI

- VT100

Enable/disable Firmware Progress Event Support.

Enable/disable Initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults

Restore the default security settings.

Computer Setup menus
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6 Specifications

Computer specifications

Metric uU.s.
Dimensions
Depth 20.90 cm 8.23in
Width 30.52 cm 12.02in
Height (front to back) 2.74cmto 3.28 cm 1.08into 1.30 in
Weight 1.67 kg 3.68 Ibs
Input power
Operating voltage 190Vdc@35A-65W
Operating current 3.5A
Temperature
Operating 5°C to 35°C 41°F to 95°F
Relative humidity
Operating 10% to 90%
Nonoperating 5% to 90%
Maximum altitude (unpressurized)
Shock
Operating 125 g, 2 ms, half-sine
Nonoperating 200 g, 2 ms, half-sine
Random vibration
Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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31.75 cm (12.50 in) display specifications

Metric u.s.
Dimensions
Width 16.9 cm 6.7 in
Depth 26.2 cm 10.3in
Diagonal 30.8cm 12.11in

Number of colors

Up to 16.8 million

Contrast ratio

250:1 (typical)

Brightness 180 nits (typical)
Backlight LED

Character display 80 x 25

Total power consumption 4.0W

Viewing angle

+/-40° horizontal, +20°/-40° vertical (typical)

31.75 cm (12.50 in) display specifications
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Hard drive specifications

750 GB* 500 GB* 320 GB* 250 GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 115¢ 101 g 101g 101g
Interface type SATA SATA SATA SATA
Transfer rate 300 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ~ ATA security =~ ATA security  ATA security
Seek times (typical read, including setting)
Single track 1.5 ms 3ms 3ms 3ms
Average 11 ms 13 ms 13 ms 13 ms
Maximum 22 ms 24 ms 24 ms 24 ms
Logical blocks 1,465,149,168 976,752,240 625,121,433 488,376,120
Disk rotational speed 7200 rpm 7200 rpm 7200 rpm 7200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive

specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD*RW and CD-RW SuperMulti Double-Layer Drive
specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT, CD-R and CD-RW

CD-ROM, CD-ROM XA, MIXED MODE

CD, CD-I, CD-I Bridge (Photo ¢cD, Video DVD+*R, DVD+RW, DVD-R, DVD-RW,
CD), Multisession CD, CD-EXTRA, DVD-RAM

Portfolio, CD-R, CD-RW), CD-R, CD-

RW, DVD-ROM (DVD-5, DVD-9,

DVD-10, DVD-18), DVD-R, DVD-RW,

DVD+R, DVD+RW, DVD-RAM

Access time CD DVD
Random <175 ms <230 ms
Cache buffer 2.5MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVD-R 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec
Transfer mode Multiword DMA Mode

DVD+RW and CD-RW SuperMulti Double-Layer Drive specifications 93



DVD-ROM Drive specifications

Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD mIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo cD,
Video CD), Multisession CD (Photo cD,
CDEXTRA, Portfolio, CD-R, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R,
DVD-RW, DVD+R, DVD+RW, DVD-
RAM

CD-R and CD-RW

Access time CD DVD
Random <110 ms <130 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 3,600 KB/sec
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7 Backup and recovery

Windows 7

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

E‘%NOTE: For detailed instructions, perform a search for these topics in Help and Support.

=¢NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

Store personal files in the Documents library, and back it up regularly.
Back up templates that are stored in their associated programs.

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1.
2,

Display the screen you want to save.

Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

E}fNOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so

using them for backup reduces the number of recovery discs required.

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

@*NOTE: Be sure that the computer is connected to AC power before you start the backup process.

@NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.
2.

Select Start > All Programs > Maintenance > Backup and Restore.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

=¥ NOTE: Windows includes the User Account Control feature to improve the security of your

computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

=»NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

E/%"NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition or the HP Recovery partition.
To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, click Start, right click Computer, click Manage, and
then click Disk Management.

=¥ NOTE: If the Windows partition or the HP Recovery partition is not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

= NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right click
Computer, click Manage, and then click Disk Management.

E’/?‘?NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Be sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD,
go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

E‘%NOTE: This process takes several minutes.

1. If possible, back up all personal files.

N

Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

N o g MW

Follow the on-screen instructions.

Windows Vista

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

e  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

E’%NOTE: For detailed instructions, perform a search for these topics in Help and Support.

E%?NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.  Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

E}fNOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

@NOTE: Be sure that the computer is connected to AC power before you start the backup process.

=¥ NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

= NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

=»NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

E/%"NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition or the HP Recovery partition. To find
the partitions, select Start > Computer.

@NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section.

3. Restart the computer, and then press 8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

@NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

/\ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled. Personal files must be restored from
a backup.

=¥ NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to
recover your operating system and software. To check for the presence of a recovery partition, select
Start > Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives
section of the window.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

E/%"NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Be sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

/\ CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

E/?’NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.  When prompted, press any keyboard key.
4. Follow the on-screen instructions.

5. Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC

The 3 conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e  The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CcOoC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3 conductor, 1.0 mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3 conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3 conductor, 1.00 mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3 conductor, 0.75 mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.  The flexible cord must be Type VCTF, 3 conductor, 0.75 mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/\ WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

ACAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

E/?’NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

=?NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel 3.
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

!
i-

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

/ E
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11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

|

I

I
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13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.
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16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.

T~ {

|

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part number
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ambient light sensor board, spare
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14
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disconnecting 56, 59
spare part number 31
audio in (microphone) jack,
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audio-out (headphone) jack,
identifying 12

B
base enclosure

removal 66

spare part number 66
base enclosure, spare part
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C
Cable Kit, spare part number 28,
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computer specifications 90
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display specifications 91
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description 3

external monitor port 15

F
fan
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function button board
removal 74
spare part number 74
function button board, spare part
number 21, 31
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function LED board, spare part
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graphics, product description 1

grounding equipment and
methods 38
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hard drive
precautions 35
product description 2
removal 60
spare part number
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heat sink
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keyboard

product description 3
removal 62
spare part number
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keyboard light button
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battery 11
caps lock 7
drive 11
HP QuickWeb 7
mute 7
num lock 7
power 7, 11
TouchPad 7
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removal 60
spare part number 22, 60
Media Card Reader, identifying
12
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product description 1
removal 48
spare part number 22, 30, 48
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identifying 12
microphone, product description
2
model name 1
modem module
removal 55
spare part number 22, 55
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num Ik key, identifying 10
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operating system, product
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optical drive
precautions 35
product description 2
removal 53
spare part number 22, 31, 53
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P
packing guidelines 37
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spare part number
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pointing stick 6
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product description 3
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removal 73
spare part number 73
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number 30
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power connector, identifying 13
power cord
set requirements 104
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power requirements, product
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processor
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removal 46
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Ethernet 2
external media cards 3
graphics 1
hard drives 2
internal storage 2
keyboard 3
memory module 1
microphone 2
modem 2
operating system 4
optical drives 2
pointing devices 3
ports 3
power requirements 3
processors 1
product name 1
security 4
solid-state drive 2
video 2
wireless 2
product name 1

Q
QuickWeb button, identifying 9

R
removal/replacement
preliminaries 34
procedures 39
RJ-11 (modem) jack, identifying
13
RJ-45 (network) jack, identifying
13
RTC battery
removal 65
spare part number 21, 32, 65
Rubber Kit, spare part number
23, 31

S
Screw Kit, spare part number 28,
31
security cable slot, identifying 12
security, product description 4
serial number 18
service access cover
removal 42
spare part number 31, 42
service access cover latch,
identifying 16
service considerations 34

114 Index

service tag 39
SIM
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removal 76
spare part number 76
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removal 76
spare part number 76
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part number 21, 31
solid state drive
spare part number 31
solid-state drive
product description 2
removal 60
spare part number
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volume keys, identifying
mute button 9
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disconnecting 56, 59
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wireless button, identifying 8
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